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Chapter 1: Introduction and Installation 
The ATVS application is available to provide the TCP/IP solution for a “true” Ethernet® time 
stamp solution. It does not simply attach to a network workstation, as with other so called 
TCP/IP solutions. ATVS enterprise software now works with the Amano TS-3000i® Automatic 
TimeSync Web clock to provide an easy-to-use auto discovery feature for connecting and 
importing the TS-3000i clocks into ATVS with a BaseT 10/100 communication speed. 

ATVS enterprise software continues to work with both the Amano PIX-3000xNT and  
PIX-3000xN time stamps. Each PIX-3000xNT has an internal NIC and is given an IP address for 
synchronization over your network. The ATVS Enterprise Software is installed on a server on 
your network. The PIX-3000xNT time stamps are then deployed anywhere on your network. 
Each time stamp requires an active available network port set to BaseT 10 communication 
speed, with network connectivity back to the single ATVS software installation. The TS-3000i, 
PIX-3000xNT, and PIX-3000xN can co-exist on the same server to provide centralized reporting 
for all these devices. 
 

How This Manual is Organized 

The installation, configuration, and operation procedures in this manual are provided for user 
assistance.  

Chapter 1 provides a brief overview of features, benefits, and system components. Also 
described is the general installation and configuration (using the Initial Wizard) guidelines. In 
most instances, configuration should only need to be completed once. 

Chapter 2 provides step-by-step procedures for general operation of ATVS. Also, this chapter 
details how to use the Setup Wizard for additions/deletions to the configuration created by the 
Initial Wizard during installation. 

Chapter 3 provides a user's guide to the operation of ATVS Scheduler. 

Chapter 4 provides a user's guide to the operation of DeviceInstaller®. 

Chapter 5 explains how to define, modify and run Report Profiles in ATVS. 

Chapter 6 contains a complete list of Action Log Messages and basic troubleshooting 
information.  
 

Introduction – What is ATVS? 

The Amano Time Validation System (ATVS) time synchronization software works in conjunction 
with one or of the TS-3000i, PIX-3000xNT, PIX-3000xN TimeSync clocks. The software and 
time clock combination may communicate by way of TCP/IP or Serial RS485 connection. 

The TS-3000i and PIX-3000-series TimeSync clocks communicate by: 

 TS-3000i clocks with Digi via Ethernet TCP/IP network connection (with unique Auto-
Discovery) 

 PIX-3000xNT clocks with NIC card via Ethernet TCP/IP network connection 

 PIX-3000xN clocks with Serial RS485 direct connection 

ATVS software runs on a Windows NT® 4.0 (or later) platform. This enables the use of standard 
network management software and backup procedures to manage, maintain, and monitor the 
software host. 
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The devices connected to the ATVS Host Server are synchronized by having the ATVS 
synchronized to the National Institute of Standards and Technology (NIST) Network Time 
Protocol (NTP) server in Boulder, Colorado, or another preprogrammed NTP source via the 
Internet. Once the ATVS Host Server has synchronized itself, the correct time is then 
transmitted to all the Amano TimeSync devices. 
 

What is OATS Compliance? 

The Amano TS-3000i, PIX-3000xN, and PIX-3000xNT TimeSync clocks, when used in 
conjunction with ATVS software, have been specially designed by Amano to be in compliance 
with the Financial Industry Regulatory Authority (FINRA) Order Audit Trail System (OATS) rule 
7430 (formerly NASD OATS Rule 6953 & NYSE Rule 132A), Synchronization of Member 
Business Clocks as described in: 

Rule 7430 requires any FINRA member firm that records order, transaction or related data required 
under the By-Laws and Rules of the Association to synchronize all business clocks used to record the 
date and time of any market event. Clocks, including computer system clocks and manual time stamp 
machines, must record time in hours, minutes and seconds with to-the-second granularity and must 
be synchronized to a source that is synchronized to within three seconds of the National Institute of 
Standards’ (NIST) atomic clock. Clocks must be synchronized once a day prior to the opening of the 
market, and remain in synch throughout the day. In addition, firms are to maintain a copy of their 
clock synchronization procedures on-site. Clocks not used to record the date and time of market 
events need not be synchronized. 

 

ATVS Software Features 

 Automatic time synchronization to an official time source. 

 Event notification through SNMP (Simple Network Management Protocol) traps. This feature 
enables network administrators to manage time clock performance, find problems, and solve 
them in a timely manner. 

 Amano has registered a unique SNMP identifier, which validates the SNMP trap feature. 

 Multiple communication options to time validation units. 

 NTP (Network Time Protocol) syncs clocks to a time reference over a data network. 

 NIST (National Institute of Standards & Technology) synchronization available via modem. 

 Direct synchronization to the time source rather than to a computer. 

 Log-in security with configurable rights to sections of application. 

 Software supports two communication options and three distinct validation units: 

- TS-3000i clocks via Ethernet TCP/IP network connection. 

- PIX-3000xNT clocks via Ethernet TCP/IP network connection. 

- PIX-3000xN clocks with Serial RS485 direct connection. 

 Synchronization logging data maintained per Order Audit Trail System (OATS) Rule 7430 
requirements. 

 Full OATS compliance with stand-alone units not linked to a PC. 

 Complete server-based solution, not on individual trader computers. 

 Reports including status/error, transaction log, and configuration settings. 

 Unlimited syncs per day for improved accuracy. 

 Compatible with Windows NT/98/2000/ME/2003/XP/Vista. 
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 Employs Windows Services to perform synchronization. 

 E-mail notification of clock status and/or failure to synchronize time, configurable to select 
group/device and send e-mail to chosen recipients. 

 

ATVS Benefits 

 Assures financial institutions’ compliance with OATS Rule 7430 as per FINRA/SEC. 

 Amano time stamp will continue to function and maintain time as a stand-alone unit, even if 
it does not receive synchronization from the provided ATVS host software. 

 The TS-3000i and PIX-3000 series are the highest quality OATS-compliant time stamps 
available. 

 Log files maintained automatically on hard drive of computer to which the software is 
installed. Logs may be e-mailed, saved or printed as desired. 

 Convenient system support provided by visible alarms on time stamp imprint and time clock 
LCD display should synchronization not occur. 

 Provides a solution for industry sectors that require strict adherence to good time keeping 
practices with detailed records. 

 

ATVS Typical User/Market 

The following list is comprised of typical users/markets for Amano ATVS: 

 Banks/Insurance  Manufacturing 

 Investment Brokers  Pharmaceutical/Healthcare (FDA 21 CFR Part 11) 

   Broker/Dealer trader Centers  Hospital/Emergency Call Centers 

   Casinos 
 

PIX-3000xN/PIX-3000xNT/TS-3000i Hardware Features 

 Maintains time less than four tenths of a second over a 24-hour period once synchronized. 

 Time imprint format includes seconds as per FINRA 7430 requirements. 

 Prints through up to 6 multiple-part carbonless copies. 

 Capable of printing alphanumeric characters in two separate lines. 

 Optional Full Power Reserve (FPR) permits clock operation and/or stamping in the event of 
power outage. 

 Quick and easy ribbon cartridge replacement. 

 Direct-connect or Ethernet connection to internal or external time servers. 

 Optional Power over Ethernet (PoE) accessory for TS-3000i eliminates the need for AC 
power. 

 

ATVS Requirements 

ATVS time synchronization software (Enterprise version) for Windows may be used in 
conjunction with Amano TS-3000i, PIX-3000xNT, and PIX-3000xN Time Recorders. 

The ATVS software may be loaded on any PC and/or server operating under Windows NT or 
later. 
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ATVS General Information 

During the installation process, both the ATVS application and ATVS Scheduler application use 
the Setup.exe file and the same supporting files. 

The installation procedure provides simple instructions on each screen. It is important to follow 
these instructions carefully in the order for the ATVS Enterprise Edition to run correctly. 

End-users may never need to change the configuration settings created thru the wizard at a 
later time after the initial configuration setup. However, it is recommended that all configuration 
settings should be recorded in the event that the setup needs to be repeated in the future. 

While the Enterprise Edition of ATVS is running, the ATVS Scheduler runs as a service. 
 

 
Figure 1-1:  Enterprise Edition ATVS Diagram 
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ATVS Installation Guide 

ATVS Initial Software Installation 

1. Turn on the computer for the ATVS application to be loaded. 

2. Verify that no additional applications are running. 

3. Insert the ATVS disk in the CD-ROM drive. 
 

 

Note – If a previous version of ATVS has been installed on your PC, the InstallShield 
Wizard will detect it. Confirm to Uninstall the previous version by clicking OK. It is 
recommended to make a copy of your existing database file which will be in the 
Program Files/ATVS/db folder and with the filename “ATVS.fdb”. When the Uninstall is 
complete, click “Finish” to end. Re-insert the ATVS CD to launch the ATVS InstallShield 
and follow the onscreen prompts. After the ATVS installation is complete, navigate to 
Program Files/ATVS/db folder and replace the “ATVS.fdb” with the copy you made of 
your database. 

 

4. The InstallShield® Wizard screen for ATVS Enterprise Choose Setup Language will appear 
as shown: 

 

 

Figure 1-2:  Choose Setup Language 
 

5. Click Next to continue the installation, and the Welcome to ATVS InstallShield Wizard will 
appear (see Figure 1-3). 

 

 

Figure 1-3:  Welcome to ATVS InstallShield Wizard 
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6. Click Next to continue the installation, and the Software License Agreement will appear to 
advise users of their legal responsibilities (see Figure 1-4). To continue the installation you 
must click Yes to accept this agreement. 

 

 

Figure 1-4:  InstallShield Wizard License Agreement 
 

 
Note – Press the Print button to print a copy of the license agreement. 

 

 
Figure 1-5:  InstallShield Wizard Customer Information 

 

7. Enter the User Name, Company Name, and ATVS serial number. Then click Next to 
continue with the setup, and the Destination Location screen will appear as shown in  
Figure 1-6. 

 

 
Figure 1-6:  InstallShield Wizard Choose Destination Location 
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8. When asked to Choose Destination Location, use the suggested Destination Folder (ATVS). 
If the drive is not applicable to your system, click the Browse button to select a drive. Then 
click Next to continue, and the Setup Type screen will appear (see Figure 1-7). 

 

 

Figure 1-7:  InstallShield Wizard Setup Type 
 

9. When asked to choose the type of setup, it is recommended to click on Server. If the PC 
you are loading ATVS on is connected to the ATVS system, you may want to click on Client. 
Then click Next to continue, and the Select Program Folder screen will appear (see  
Figure 1-8). 

 

 
Figure 1-8:  InstallShield Wizard Select Program Folder 

 

10. When asked to enter a server's (PC) IP Address, use the suggested localhost, and click 
Next to continue (see Figure 1-9). 

 

 

Figure 1-9:  InstallShield Wizard Enter Text 
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11. During installation, the installation will check for the presence of the Adobe Acrobat Reader, 
necessary for the display of PDF-formatted reports. If no Reader is present, that application 
will install. During that process, the following screen will briefly appear: 

 

 
 

12. Next a Setup Status screen will appear showing a progress status bar for the ATVS 
installation as shown in Figure 1-10. 

 

 
Figure 1-10:  InstallShield Wizard Setup Status 

 

13. During installation, if desired, click Yes to create a desktop icon for ATVS  
(see Figure 1-11). 

 

 
Figure 1-11:  Desktop Icon Dialog 

 

14. The InstallShield Wizard Complete will appear (see Figure 1-12) when done. 
 

 
Figure 1-12:  InstallShield Wizard Complete 
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15. Click on Finish, and if the box "Would you like to run ATVS now?" is checked, the program 
will immediately start, and the following screen will appear signifying the ATVS Scheduler 
service is starting (see Figure 1-13). 

 

 

Note – See the next section, "ATVS Software Activation”, which should normally be 
performed immediately following the ATVS software installation. 

 

 

Figure 1-13:  ATVS Scheduler Service Starting 
 

ATVS Software Activation 
 

1. Figure 1-14 displays the Activate screen which appears the first time the program is started 
up after initial installation. Enter the serial number supplied with the software and click on 

the Activate  button. If activation is successful the "Activation was successful. 
Would you like to register?" screen will appear (skip to step 4). 

 

 
Figure 1-14:  Activate ATVS 

 

If you choose not to Activate the software at this point by canceling the activation the 
following error message will appear (see Figure 1-15). At this point you have a trial period of 
up to 14-days to use the ATVS software. During this period you must successfully activate 
the software. Click the OK button to launch the ATVS program and display the Initial Wizard 
screen (from here proceed to step 1 of the ATVS Initial Configuration). 
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Figure 1-15:  ATVS Authorization Failed 

 

2. If an Activation error dialog message appears (see Figure 1-16), the serial number is 
incorrect, no Internet connection with the Amano authorization server occurred, or the same 
serial number was previously installed. 

 

 

Figure 1-16:  Failed to Activate Customer Support Required 
 

3. If the serial number is valid, but customer support is desired click on the Phone In 

 button from the Activate screen and the Activate ATVS screen for customer 
support will appear (see Figure 1-17). 

 

 

Figure 1-17:  Activate ATVS with Customer Support 
 

Call Amano support at 1-800-896-7035 and the support personnel will ask for the CS Key 
code letters displayed on your screen (see Figure 1-17). Enter the supplied [from Amano 
support] RS Key code into the appropriate fields in five character increments. Click on the 

Activate  button to activate and launch the ATVS program. 

4. Upon successful authorization the following screen will appear (see Figure 1-18). Click Yes 
to register. 

 

 
Figure 1-18:  Confirm ATVS Activation 

 

Alternately, the registration can be skipped by clicking the No button. However, it is 
suggested at this time to register, but you can always register later by clicking on the File 
menu and pulling down to Register to open the registration screen (see the following 
figure). 
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Note – You cannot register the software until the activation process is complete. 

 

5. Enter the appropriate information in the registry fields (see Figure 1-19). The minimum 
information required to successfully register is: Last Name, First Name, City, and Type [Red 
outlined fields]. Select the type from the dropdown menu, and click OK to register and 
launch the ATVS program to display the Initial Wizard (see Figure 1-20). 

 

 

Figure 1-19:  ATVS Registration 
 

Click the Cancel button to abort the registration process to perform at a later time. The 
ATVS Initial Wizard screen should now appear (see Figure 1-20). 

 
 

ATVS Initial Configuration 

1. After the ATVS Scheduler and Config programs have started, the Initial Wizard screen for 
ATVS will appear. All 4 steps must be completed to finish the initial configuration and 

installation. If the Exit  button is pressed before the initial Wizard completion a warning 
confirmation dialog will appear. The next time ATVS is started the Initial Wizard screen will 
pickup with the last completed step. It is suggested to complete all the steps in numerical 
order. 

 

 
Note – The green checkmarks indicate when a step is complete. 
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Figure 1-20:  Initial Wizard 

2. For Step 1, from the Initial Wizard, click on the Create Users  icon and the Users 
screen will appear (see Figure 1-21). 

 

 

Figure 1-21:  Users General Tab 
 

3. Enter a Name, Password [6 character minimum], and Confirm Password. Note that user 
names and password are case-sensitive. If Manager is not checked, click on the Rights tab 
to select the rights (see Figure 1-22). From the Available list, select the Rights by using the 

selection arrows (  or ) to move them to the Selected list on the right. 
 

 
Note – If Manager is checked, then the "Rights" tab will not appear as all rights will 
automatically be assigned to this user. 

 

 

Figure 1-22:   Users Rights Tab 
 

4. Click on the Advanced Password tab to select a password expiration of: Never Expire, 
Expires after, or Expires On (see Figure 1-23). The default is Never Expire, so this screen 
can be skipped if the default selection is acceptable. 

 



 

ATVS Enterprise Edition v5.2 Installation & Operation Guide 1-13 

 

Figure 1-23:  Users Advanced Password Tab 
 

5. When finished entering each new user in this step, click on the Save  button to save 

the user settings. When finished creating all new users, click on the Close  button to 
return to the Initial Wizard screen. 

6. Step 1: Users Wizard is now complete, and the Initial Wizard screen will indicate this 
with a green checkmark. 

7. For Step 2: Groups, from the Initial Wizard, click on the Create Groups  icon and 
the Group screen will appear (see Figure 1-24). 

 

 

Figure 1-24:  Create Groups General Tab 
 

8. Enter a Name and Description. The SNMP Server(s) tab should not be used at this 
moment. See Step 1: Communication for more information about setting up SNMP Servers 
for SNMP traps. 

 

 
Note – If "Enabled" is checked, then the Group will be active. 

 

9. When finished entering each new group, click on the Save  button to save the group 

settings. When finished creating new groups, click on the Close  button to quit, and 
return to the Initial Wizard screen. 

10. Step 2 is now complete, and the Initial Wizard screen will indicate this with a green 
checkmark (see Figure 1-25). 
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Figure 1-25:  Initial Wizard Step 2 Complete 
 

11. For Step 3, from the Initial Wizard, click on the Create Devices  icon and the Device 
screen will appear (see Figure 1-26). 

 

 

Figure 1-26:  Create Devices General Tab 
 

12. Enter the Name for the clock (device). Select the Amano clock Type (device) from the 
dropdown menu of TS-3000i, PIX-3000xNT, or PIX-3000xN. Enter the IP Address and 
MAC Address, if known, for the Ethernet TS-3000i or PIX-3000xNT only. The serial PIX-
3000xN will require the COM Port instead of the IP and MAC Address to be entered. Enter 
the acceptable Max Deviation in milliseconds (default = 1500 milliseconds or 1.5 seconds) 
between the ATVS and the Time Server. Click on Enabled to make this Time Server active. 

13. If the IP address/MAC Address is unknown (for TS-3000i or PIX-3000xNT), click on the 

Import Device(s)  button on the bottom of the Device screen to open to the Import 
Devices screen. Import Devices function can be used to locate TS-3000i clocks with 
Zeroconf auto discovery feature and find IP/MAC address for PIX-3000xNT using 
DeviceInstaller. 
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To Import TS-3000i clocks: 

14. Select TS-3000i from the dropdown menu for the type of device to import (see Figure 1-27). 
 

 

Figure 1-27:  Select Device Type 

15. This step is optional and should usually be skipped for TS-3000i import. Only perform this 
step if having problems with auto discovery. Please note - the screen has changed (see 
Figure 1-28) to allow Domain Name change for the search (default = local). Also, you can 
select the timeout time allowed for the search from the dropdown (default = 1 minute). 

 

Note – If default values are ok, just select TS-3000i and click on the Import 
tab. 

 

 

Figure 1-28:  Normal Import TS-3000i Settings 
 

16. Click on the Import tab to display a blank Import Devices screen. Click on the  

Start TS-3000i Discovery  button. To stop auto discovery, simply click on the  

Stop TS-3000i Discovery  button. Searching for the clocks will automatically timeout. 

17. All of the discovered TS-3000i clocks will be displayed in a list with their Device Type, IP 
Address, MAC Address, Device Name, and Group Name. Imported TS-3000i clocks will 
automatically be given the group name of “TS-3000i Default Group” (see Figure 1-29). 

 

 

Figure 1-29:  Discovered TS-3000i Clocks 
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18. Select the desired TS-3000i clocks and click on the  button to import 
these clocks into the ATVS software. The dialog “Are you sure” will appear (see Figure 
1-30). Click the OK button to perform the operation. The operational status will appear in the 
display window to show that the selected clock(s) have been imported (see Figure 1-29). 

 

 

Figure 1-30:  Confirm Import Dialog 
 

19. Close the Import Devices screen and select the desired TS-3000i imported clock from the 
list on the right-hand side (see Figure 1-31). The name, IP and MAC addresses will 
automatically be brought into the device file. Note – the Description field will be auto-
populated with the text: “This device was created in the import module.” Also, the Launch 

Web Browser  button will appear alongside the clock name to automatically connect to 
the clock Web page when clicked on. 
 
Repeat the process detailed in this step for each new TS-3000i clock imported into ATVS. If 
all of the imported information for the TS-3000i clocks is acceptable and does not have to 
be changed in ATVS, for example the clock’s name, nothing else has to be done. Also, if the 
imported TS-3000i clock name is changed in ATVS, it will remain unchanged in the  
TS-3000i clock unless changed by logging into the clock and saving a new name. See the  
TS-3000i Installation & Operation Guide for complete details on TS-3000i operation. 

 

 

Figure 1-31:  Device Imported TS-3000i Selection 
 
 
 
 

Click on Web 
Browser button 
when active to 
login the TS-3000i 
clock. 
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To Import PIX-3000xNT clocks: 
 

20. Select PIX-3000xNT from the dropdown menu on the Import Devices screen for the type of 
device to import (see Figure 1-32). 

 

 

Figure 1-32:  Select PIX-3000xNT Device Type 

21. Click on the PIX-3000xNT Device Lookup  button to launch the DeviceInstaller  
(see Figure 1-34). 

 

 
Figure 1-33:  DeviceInstaller 

 

22. With the DeviceInstaller open, click on the Magnifying glass  to search for the  
PIX-3000xNT IP/MAC addresses. Figure 1-34 shows a search example. 

 

 
Figure 1-34:  DeviceInstaller Search Results Example 
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23. All PIX-3000xNT devices that are detected here may be imported. If no group is specified, 
each device imported will automatically be installed to a default group. If the group 
associated to a device needs to be changed at a later time, please refer to the section 
Moving a Device to Another Group and see Chapter on DeviceInstaller Use. 

24. Click on File on the DeviceInstaller menu and select the Save As sub-menu  
(see Figure 1-35). 

 

 

Figure 1-35:  DeviceInstaller File Menu 
 

25. From the Save As dialog (see Figure 1-36), select a destination folder [Save in:] and File 
name. Click the Save button and a text file with the IP/MAC search results will be saved. 

 

 

Figure 1-36:  Save As Dialog 
 

26. Close the DeviceInstaller, and from the Import Devices screen click alongside the Import 

File Location field on the Browse  button and navigate to the saved “Devices.txt” file 
from the previous step. Once the file is selected, click on the Open button and the path for 
the text file with the IP/MAC search results will appear in the "Import File Location" field  

(see Figure 1-37). Click on the Load File  button to load the Device file into the 
Import Devices function and the device status information will appear on the bottom of the 
Import Devices screen in the operation status field. 
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Figure 1-37: Load PIX-3000xNT Device 

 

27. Click on the Import tab to display a list of PIX-3000xNT devices to import that you just 
loaded from the previous step. Just select the desired devices to import if you do not want to 
import all the devices on the list (see Figure 1-38). 

 

 
Figure 1-38:  Device List from Loaded Devices 

 

28. Click on the Import Selected Device(s)  button to import all the 
selected PIX-3000xNT devices into ATVS. The operational status of the import will be 
displayed below on the Import Devices screen. 

29. Close the Import Devices screen and you will be back on the Device screen. Click on the 
imported device from the list on the right and that device information will appear in the 
proper fields on the device screen (see Figure 1-39). 
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Figure 1-39:  Imported Device 

 

30. After the TS-3000i, PIX-3000xNT, and/or PIX-3000xN clock (device) has been 
created/imported, click on the Other Options tab, and the screen will appear as shown in . 
Either use the local Time Zone, or select the appropriate time zone from the dropdown 
menu. The Time Zone selected controls the specific Time Zone adjustment sent to the 
individual PIX-3000 device currently being configured within your ATVS setup. The setup for 
each PIX-3000 device allows for custom Time Zone configuration. Where OATS compliance 
is necessary, verify that the Use Local PC Time Zone option is not checked. The Time Zone 
must be set to (GMT-05:00) Eastern Time (US & Canada). 

 

 

Figure 1-40:  Device Other Options Tab 
 

31. When finished entering each new device, click on the Save  button to save the device 

settings. When finished creating new devices, click on the Close  button to quit and 
return to the Initial Wizard screen. 
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Note – See Chapter 4 for complete procedure to add/import PIX-3000xN and  
PIX-3000xNT devices. 

 

32. For Step 4 from the Initial Wizard, click on the Create Time Servers  icon, and the 
Time Server screen will appear (see Figure 1-41). 

 

 

Figure 1-41:  Create Time Server 
 

33. Enter a Name, and select the server type from the dropdown choices of; NTP, NIST (US), 

NPL (UK), or PTB (DE). For NTP, click on the  button and a list of suggested NTP 
servers will appear to choose from (see Figure 1-42). 

For NIST, NPL, or PTB, click on the  button and a default modem phone number for 
that server will appear in the Phone Number field. The default modem phone numbers are 
only a start, and any valid phone number can be entered in this field. Also, the Com Port 
field will be active to enter the desired Com Port. (When using a NIST, NPL or PTB time 
server, a modem and phone line connection are necessary.) 

Enter the Max Deviation. The default is 1500 ms (1.5 seconds). 
 

 

Figure 1-42:  NTP Servers 
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34. When finished entering each new Time Server, click on the Save  button to save the 

Time Server settings. When finished creating new Time Servers, click on the Close  
button to quit, and return to the Initial Wizard screen. 

35. The Initial Wizard is now complete (see Figure 1-43). Click on the Finish button. 
 

 

Note – The user can quit the initial wizard at any time during the step-by-step process 

by clicking on the Exit  icon. However, all 4 steps must be completed with the 
minimum required information before the installation process is complete. 

 

 

Figure 1-43:  Initial Wizard Complete 
 

36. A user can now login, and the ATVS program will start with the Login (see Figure 1-44). 
 

 

Figure 1-44:  ATVS Login 
 

37. Enter the correct Username and Password (previously defined in Step 1: Users), and the 
ATVS Config screen will appear (see Figure 1-45). 
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Figure 1-45:  ATVS Config Main Screen 
 

38. The ATVS software installation is now complete. You can remove the Amano ATVS 
installation disk from the CD-ROM drive. 

 

 

Note – The ATVS Scheduler and ATVS Config programs will automatically start after 
the installation to complete the configuration. See Chapter 2: ATVS Config Operation, 
Step 2: Schedule in order to set up the schedules, E-mail, Reports, and/or System 
Options in ATVS Config before using the program. After installation, ATVS 
Scheduler will be added to the Windows Startup Menu, so that it will automatically run 
as a service whenever a user logs onto Windows. 
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Chapter 2: ATVS Config Operation 

General Information 

After ATVS has been installed on a PC and the initial setup wizard completed, the ATVS Config 
program will automatically start. 

To configure the system, you must: 

 Prepare synchronization schedules. 

 Verify that the installed TS-3000i’s and PIX-3000xNT’s are connected to the Ethernet 
network which has the ATVS system and are recognized by ATVS to be configured 
properly. All PIX-3000xN’s would be connected by serial connection to the ATVS system. 

 Define groups that reference the locations of the installed TS-3000i, PIX-3000xNT, and/or 
PIX-3000xN Time Recorders (using the Wizard). 

 Add and configure the TS-3000i, PIX-3000xNT, and/or PIX-3000xN Time Recorders that will 
be used in each group (using the Wizard). 

 Assign communication parameters (IP addresses and COM ports) to each TS-3000i, PIX-
3000xNT and/or PIX-3000xN (using the Wizard). 

 Assign the NTP servers that will be used to synchronize your ATVS host (using the Wizard). 

 Choose the system settings, time zone, and Daylight Saving Time (DST) that are applicable 
to your installation (using the Wizard). 

 

 
Note – Users should be reminded that this configuration usually remains unchanged 
after installation. Any questions can be directed to Amano's technical support. 

 
 

ATVS Config Startup 

At startup, ATVS will display the ATVS Startup and Login screen (see Figure 2-1). 
 

 

Figure 2-1:  ATVS Startup and Login 
 

Enter the case-sensitive Username and Password (previously defined during the Initial Wizard), 

then click on the Login  button and the ATVS Config main screen will appear  
(see Figure 2-2). 
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ATVS Config Layout 

Figure 2-2 displays the default main view of ATVS Config screen and identifies its various 
sections. This view can be changed based upon the selection made from the menu selections 
and/or the tree view selections on the left-hand side of the screen. 
 

 

Figure 2-2:  ATVS Main Screen Layout 
 
 

ATVS Config Main Dropdown Menus 

File Menu 

The File menu provides the following functions: The "Activate" selection allows entry of the 
product serial number, necessary for continued operation of the software beyond the 14-day 
trial period allowed during initial installation; "Register" allows you to register as a new ATVS 
user, “Log Off” allows you to log off the program without quitting the application; Selecting "Exit" 
quits the application. 
 

 
 

Communication Menu 

The Communication menu has two synchronization methods: 

 Obtain Time Server time, and then sync devices 

 Use the host PC’s time for synchronization, not employing any recognized Time Server 
(generally, not the preferred method) 
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Tools Menu 

The Tools menu allows you to configure the ATVS application by following a numbered step-by-
step process using the "Setup Wizard". 

The "Device Lookup" sub-menu selection will launch "DeviceInstaller", which can be used to 
typically find and configure PIX-3000 devices for ATVS communications. 

The "Import Devices" sub-menu selection will launch the Import Devices screen allowing IP 
addresses and/or MAC addresses to be loaded directly into the Device configuration (see 
Wizard Step 1.3: Devices for more information). Typically used to auto discover TS-3000i’s. 

The "Rebuild Data" sub-menu selection provides the ability to rebuild the data table for the 
Device Report. 
 

 
 
 

Help Menu 

The Help menu "About" selection (see Figure 2-3) will provide you with the current version of 
ATVS that you are using. This information is required when placing a support call. 

The "Help F1" selection provides online help. 

The "Manual" selection will launch a PDF version of the ATVS Installation and Operation Guide 
(AJR-40120X). 

 
 

 

Figure 2-3:  About ATVS 
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Common Buttons 

Certain common functions are performed using buttons. These buttons are shown below. In the 
following table, the names shown in the description column explain the associated function. 
Within the application, hovering the cursor over a button will display the tool tip description. 
 

 
 
 

Wizard Icons 

Certain wizard functions are performed using icons. These icons are shown below. In the 
following table, the names shown in the description column explain the associated function. 
Hovering the cursor over an icon will display the tool tip description. 
 

 
 
 



 

ATVS Enterprise Edition v5.2 Installation & Operation Guide 2-5 

 

Using the ATVS Config Setup Wizard 

Step 1: Communication 

1. From the ATVS Config screen, click on the Tools menu, and select the Wizard. The Setup 
Wizard screen will appear (see Figure 2-4). It is recommended to configure ATVS in the 
step-by-step order displayed in the Setup Wizard. The Setup Wizard will always start at Step 
1: Communication. 

 

 

Figure 2-4:  Setup Wizard Step 1 
 

2. For Step 1.1, click on the Create SNMP Servers  icon, and the SNMP Server screen 
will appear (see Figure 2-5). Enter information into the required fields: Name, IP Address, 
Port, and Community Name. 

 

 

Figure 2-5:  Create SNMP Server 
 

 
Note – All fields outlined in Red should be completed. 

 

3. When finished defining an SNMP Server, click on the Save  button to save your SNMP 

Server and return to the Setup Wizard screen. Click on the Close  button to quit without 
saving. The new SNMP Server information will be displayed to the right of the tree view list. 

4. From the Setup Wizard screen, for Step 1.2, click on the Create Groups  icon, and 
the Group screen will appear (see Figure 2-6). 
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Figure 2-6:  Create Group General Tab 

 
Note – All fields outlined in Red should be completed. 

 

 

Note – When the TS-3000i clock is imported, the Group Description field will say, 
"This group was created in the import module". When a PIX-3000xNT is 
imported, the Group Description field will say, "This group created from 
Device Import module" 

 

5. Enter information in the required Name field, and elective Description field. Click on the 
Enabled box to enable all devices within the group. Then click on the SNMP Server(s) tab, 
and the screen will appear as shown in Figure 2-7. Next assign SNMP Servers, from the 
Available list (default status for SNMP Servers previously defined in Step 1.1), select the 

SNMP Servers by using the selection arrows (  or ) to move them to the Selected 
list on the right from the Available list on the left. 

 

 

Figure 2-7:  Group SNMP Servers Tab 
 

6. When finished entering each new Group, click on the Save  button to save the Group 

settings. When finished creating all new groups, click on the Close  button to quit, and 
return to the Setup Wizard screen. 

7. From the Setup Wizard, for Step 1.3, click on the Create Devices  icon, and the 
Device screen will appear (see Figure 2-8). 
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Figure 2-8:  Device General Tab 
 

8. Select the desired Group from the dropdown menu (imported clocks will automatically be 
placed in a group called “Default Group”). Enter the Name for the clock (device). Select the 
Amano clock Type (device) from the dropdown menu of TS-3000i, PIX-3000xN, or PIX-
3000xNT. Enter the IP and MAC Address if known for the Ethernet TS-3000i and PIX-
3000xNT clocks. If unknown for TS-3000i or PIX-3000xNT click on the Import Device(s) 

 button and the Import Devices screen will launch (see Figure 1-27). Follow the 
procedure outlined for the Initial Wizard for importing TS-3000i and PIX-3000xNT clocks. 
Also, consult the DeviceInstaller chapter. 
 

 

Note – For an alternate procedure to find the IP and MAC Address for a PIX-3000xNT 
close the Device screen and click on the Tools Menu and select the Device Lookup 
sub-menu selection. This will launch the “DeviceInstaller” (see Figure 4-1). 

For PIX-3000xN's, the Com Port field will be active to enter the desired Com Port. 

9. Enter the desired acceptable Max Deviation between ATVS and the Time Server. The 
default is 1500 milliseconds (1.5 seconds). 

10. Then click on the Other Options tab, and the screen will appear as shown in Figure 2-9. 
Either use the local computer's time zone (default), or select the appropriate Time Zone from 
the dropdown menu. The Time Zone selected controls the Time Zone adjustment sent to the 
selected device. Where OATS compliance is necessary, verify that the Use Local PC Time 
Zone option is not checked. The Time Zone must be set to (GMT-05:00) Eastern Time (US 
& Canada). 
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Figure 2-9:  Device Other Options Tab 

11. Enter the required information. When finished entering each new Device, click on the Save 

 button to save the Device settings. When finished creating all new devices, click on the 

Close  button to quit, and return to the Setup Wizard screen. 

12. From the Setup Wizard, for Step 1.4, click on the Create Time Servers  icon, and the 
Time Server screen will appear (see Figure 2-10). 

 

 

Figure 2-10:  Create Time Server General Tab 
 

13. Enter the required information. When finished entering each new Time Server, click on the 

Save  button to save the Time Server settings. When finished creating all new time 

servers, click on the Close  button to quit, and return to the Setup Wizard screen. 
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Step 2: Schedule 

1. From the Setup Wizard click on the Next Step  button, to advance to  
Step 2.1 : Schedule (see Figure 2-11). 

 

 

Figure 2-11:  Setup Wizard Step 2.1 Schedule 
 

2. Click on the Create Schedules  icon, and the Schedule screen will appear  
(see Figure 2-12). 

 

 

Figure 2-12:  Schedule General Tab 
 

The Create Schedules icon is used to setup the schedules for time synchronization and 
reporting. At these user-specified times, ATVS will synchronize the TS-3000i, PIX-3000xNT 
and PIX-3000xN Time Recorders connected to the ATVS. 

An unlimited number of schedules and events per day can be set. When creating schedules, 
verify that the Sync with Time Server First option is checked. This enables the ATVS to 
seek synchronization with a time server first before transmitting the time to all connected  
TS-3000i, PIX-3000xN, and PIX-3000xNT Time Recorders. 

 

 

Note – When using ATVS with the TS-3000i, ATVS will act as the Master with the  
TS-3000i acting as the slave. Therefore, most of the transaction information from time 
sync schedules will be stored in the ATVS database and not in the flash memory of 
the TS-3000i clock. The transaction database in the TS-3000i will just record a single 
line which says; “An ATVS time sync occurred at DD/MM/YYYY (date). Also, all 
controlling configuration parameters will reside in ATVS and not the TS-3000i. 

Upon startup, the TS-3000i will automatically perform a “Startup Sync”. After, the TS-3000i 
is imported into ATVS and time sync schedules are enabled, ATVS will become the master 
for time sync information. When the TS-3000i is the slave, all internal time sync schedules 
will be ignored. 
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Note – The PC running the ATVS software will always reflect the time retrieved from 
the time server. Therefore, the time setting on this PC time may not be the same as 
your local time. 
If the host PC uses a version of Windows that provides its own atomic clock 
synchronization utility, it is recommended to disable this option, as this method is less 
accurate and would conflict with the more accurate timekeeping of ATVS. 

 

3. Enter the required General field information. Select the schedule recurrence. The choices 
are: Daily, Weekly, Monthly, or Yearly. 

4. Click on the Options tab, and an example of a possible screen that could appear is shown 
in Figure 2-13. 
 
If Daily is selected, then define Every, Start Date [use calendar], Start Time [click in the field 
to change time], and check Run Every X min(s) to set the number of minutes. 
 
If Weekly is selected, then define Recur every week(s) on X day [check box for each day] or 
check box for All Week, Start Date [use calendar], and Start Time [click in the field to change 
time]. 
 
If Monthly is selected, then define Day X of every N month(s), Start Date [use calendar], 
and Start Time [click in the field to change time]. 
 
If Yearly is selected, then define Every X month for N date, and Start Time [click in the field 
to change time]. 

 

 

Figure 2-13:  Schedule Options Tab 
 

5. Enter the required Options information. Click on the Group(s) tab, and the screen will 
appear as shown in Figure 2-14. If desired, from the Available list (default status for Groups 

previously defined in Step 1.2), select the Group(s) by using the selection arrows (  or 

) to move them to the Selected list on the right from the Available list on the left. 
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Figure 2-14:  Schedule Group(s) Tab 
 

6. Click on the Device(s) tab, and the screen will appear as shown in Figure 2-15. If desired, 
from the Selected list (default status for devices previously defined in Step 1.2), deselect the 

Device(s) by using the selection arrows (  or ) to move them from the default 
Selected list on the right to the Available list on the left. 

 

 
Note – The devices will be automatically selected once the Groups are selected in the 
previous step. 

 

 

Figure 2-15:  Schedule Device(s) Tab 
 

7. When finished defining a Schedule, click on the Save  button to save your Schedule. 

Click on the Close  button to quit without saving and return to the Setup Wizard screen. 
The new Schedule information will be displayed to the right of the tree view list. 

 
 

Step 3: E-Mail 

1. From the Setup Wizard click on the Next Step  button, to advance to Step 3: E-Mail, 
and the Setup Wizard screen will appear for Step 3: E-Mail (see Figure 2-16). 
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Figure 2-16:  Setup Wizard Step 3: E-Mail 
 

2. For Step 3.1, click on the Create E-Mail Accounts  icon, and the E-Mail Account 
screen will appear (see Figure 2-17). 

 

 

Figure 2-17:  Create E-Mail Account 
 

The Create E-Mail icon is used to setup the E-Mail for status report notification. 

The Enabled option, when checked, will automatically send an e-mail notification to the 
remote support or help desk that the scheduled event has been completed. For proper 
operation, the mail (SMTP) server must be specified in Step 1.1, and the addresses and 
message must be set in the following E-mail templates. 

3. From the Setup Wizard, for Step 3.2, click on the Create E-Mail Templates  icon, and 
the E-Mail Template screen will appear (see Figure 2-18). 
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Figure 2-18:  E-Mail Template General Tab 
 

4. Enter the required general information; Name, E-Mail From [select address from previously 
defined addresses by pressing the Select button – see Figure 2-19], Event [select from 
dropdown list], enter Subject and Message. 

 

 

Figure 2-19:  E-Mail Account(s) For From 
 

5. Then click on the E-Mail To tab, and the screen will appear as shown in Figure 2-20. From 
the Available list (e-mail addresses previously defined in Step 3.1), select the desired emails 

by using the selection arrows (  or ) to move them to the Selected list on the right. 
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Figure 2-20:  E-Mail Template E-Mail To Tab 
 

6. Figure 2-21 is an example of the ATVS system sending an e-mail notification to the 
designated E-Mail To recipient. 

 

 

Figure 2-21:  Example of E-Mail Notification 
 

7. When finished defining an E-Mail template, click on the Save  button to save your E-Mail 

template settings. Click on the Close  button to quit without saving and return to the 
Setup Wizard screen. The new general E-Mail information will be displayed to the right of 
the tree view list. 

 
 

Step 4: Users 

1. From the Setup Wizard, click on the Next Step  button, to advance to Step 4: Users, 
and the Setup Wizard screen will appear for Step 4.1:Users (see Figure 2-22). 
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Figure 2-22:  Setup Wizard Step 4: Users 
 

2. For Step 4.1, click on the Create Users  icon, and the Users screen will appear  
(see Figure 2-23). 

 

 

Figure 2-23:  Users General Tab 
 

 
Note – Any Users already created will appear in the pane at the window's right. 

 

3. Enter the required general user field information. If Manager is not checked, click on the 
Rights tab, and the screen will appear as shown in Figure 2-24. From the Available list, 

select one or more Rights by using the selection arrows (  or ) to move them to the 
Selected list on the right. At least one right must be selected for the User to exist in the 
system. 

 

 
Note – If Manager is checked, then the "Rights" tab will not appear as all rights will 
automatically be assigned to this user. This is the default setting. 

 

 

Figure 2-24:  Users Rights Tab 
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4. Click on the Advanced Password tab, and the screen will appear as shown in Figure 2-25. 
From the 3 choices select one of the following for the highlighted user: Never Expire, 
Number of Days, or Specific Date. The default is Never Expire. 

 

 

Figure 2-25:  Users Advanced Password Tab 

5. When finished entering each new User, click on the Save  button to save the User 

settings. When finished creating all new Users, click on the Close  button to quit, and 
return to the Setup Wizard screen. 

 

Step 5: System 

1. Click on the Next Step  button, to advance to Step 5: System, and the Setup Wizard 
screen will appear for Step 5: System (see Figure 2-26). 

 

 

Figure 2-26:  Setup Wizard Step 5: System 
 

2. For Step 5.1, click on the Setup System Settings  icon, and the System Settings will 
appear (see Figure 2-27). 

 

 

Figure 2-27:  General System Settings 
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3. Use the local PC time zone, or select the desired time zone, and check whether or not 
daylight savings is applicable. Note the Time Zone selected determines the Time Zone for 
only the PC on which ATVS is installed, and is independent of the Time Zone for each  
TS-3000i, PIX-3000xNT, and PIX-3000xN clock connected to that PC (each TS-3000i,  
PIX-3000xNT and PIX-3000xN may have its Time Zone separately configured). 

Select to Ignore NTP Time Server deviation error after the first sync cycle: This option 
should be checked if you want to send Trap/Email only for the last failed server sync 
attempt. 

Select to Only send Time Server failure messages [SNMP trap and/or email] if it 
completely fails to download the time: This option should only be checked if you want to 
send Trap-Email only for all failed sync servers. 

Select Time Server Sync Cycle Retry from the dropdown. The default = 3. This is the 
amount of times the Time Server will try to sync with the clock(s). 

 

 

Note – Service port selection is not available using the Wizard from the Tools menu. 
It is only available during the Initial Wizard setup or by clicking on System Options 
from the tree view (see General System Options). 

 

Also, set the time format [either 24 hour military, or 12 hour (AM/PM)] for the ATVS 

Scheduler to display. When finished defining the System settings, click on the Save  
button to save the System settings and return to the Setup Wizard screen, or click on the 

Close  button to quit without saving. 

4. Click on the Close  button on the bottom of the Setup Wizard to Exit and finish the 
Wizard. 

 

Using ATVS Config 
 

How to Create Users 

1. Click on the Users  icon in the tree view (see Figure 2-28), and the previously defined 
Users will appear to the right of the tree view. 

 

 

Figure 2-28:  Select Users 
 

2. Select the Add  button on the bottom of the displayed Users, and the Users screen will 
appear (see Figure 2-29). 
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Figure 2-29:  Users General Tab 
 

 
Note – Any Users already created appear in the pane at the window's right. 

 

3. Enter the required general user field information. If Manager is not checked, click on the 
Rights tab, and the screen will appear as shown in Figure 2-30. From the Available list, 

select one or more Rights by using the selection arrows (  or ) to move them to the 
Selected list on the right. At least one right must be selected for the User to exist in the 
system. 

 

 
Note – If Manager is checked, then the "Rights" tab will not appear as all rights will 
automatically be assigned to this user. This is the default setting. 

 

 

Figure 2-30:  Users Rights Tab 
 

4. Click on the Advanced Password tab, and the screen will appear as shown in Figure 2-31. 
From the 3 choices select one of the following for the highlighted user: Never Expire, 
Number of Days, or Specific Date. The default is Never Expire. 

 

 

Figure 2-31:  Users Advanced Password Tab 
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5. When finished entering each new User, click on the Save  button to save the User. 

When finished creating all new Users, click on the Close  button to quit. 
 
 
 
 
 
 
 
 
 
 

How to Delete Users 

1. To delete a User in ATVS Config, click on Users in the tree view (see Figure 2-28). 

2. Select the desired User from the list, and click on the Delete  button. A dialog box will 
appear to confirm the deletion (see Figure 2-32). 

 

 
Figure 2-32:  Confirm Deletion Dialog 

 

3. Clicking on the Yes button will delete the selected User. 
 
 

How To Modify Users 

1. Select a User from the list (see Figure 2-28), and double-click on it, or click on the Edit  
button. 

2. Type in the modified information (see How to Create a User) for the User and click on the 

Save  button. The modified User will be displayed in the tree view list. 
 
 

How to Create an SNMP Server 

1. Click on the SNMP Servers  icon in the tree view (see Figure 2-33), and the 
previously defined SNMP Servers will appear to the right of the tree view. 

 

 

Figure 2-33:  Select SNMP Servers 
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2. Select the Add  button on the bottom of the displayed SNMP Servers, and the SNMP 
Server screen will appear (see Figure 2-34). Enter information into the required fields: 
Name, IP Address, Port, and Community Name. 

 

 

Figure 2-34:  Create SNMP Server 
 

 
Note – All fields outlined in Red should be completed. 

 

 

Note – When finished defining an SNMP Server, click on the Save  button to save 

your SNMP Server, or click on the Close  button to quit without saving. The new 
SNMP Server information will be displayed to the right of the tree view list. 

 
 

How to Delete an SNMP Server 

1. To delete an SNMP Server in ATVS Config, click on SNMP Servers in the tree view (see 
Figure 2-33). 

2. Select the desired SNMP Server from the list, and click on the Delete  button. A dialog 
box will appear to confirm the deletion (see Figure 2-35). 

 

 
Figure 2-35:  Confirm Deletion Dialog 

 

3. Clicking on the Yes button will delete the selected SNMP Server. 
 
 

How To Modify an SNMP Server 

1. Select an SNMP Server from the list (see Figure 2-33), and double-click on it, or click on the 

Edit  button. 

2. Type in the modified information (see How to Create an SNMP Server) for the SNMP Server 

and click on the Save  button. The modified SNMP Server will be displayed in the tree 
view list. 
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How to Create A Schedule 

The Schedules icon is used to setup the schedules for time synchronization and reporting. At 
these user-specified times, ATVS will synchronize the TS-3000i, PIX-3000xNT and PIX-3000xN 
Time Recorders connected to the ATVS. 

ATVS can handle an unlimited number of schedules and events per day. When creating 
schedules, verify that the Sync with Time Server First option is checked. This enables the 
ATVS to seek synchronization with a time server first before transmitting the time to all 
connected TS-3000i, PIX-3000xNT and PIX-3000xN Time Recorders. 
 

 

Note – The PC running the ATVS software will always reflect the time retrieved from 
the time server. Therefore, the time setting on this PC time may not be the same as 
your local time. If the host PC uses a version of Windows that provides its own atomic 
clock synchronization utility, it is recommended to disable this option, as this method 
is less accurate and would conflict with the more accurate timekeeping of ATVS. 

 

1. Click on the Schedules  icon in the tree view (see Figure 2-36), and the previously 
defined Schedules will appear to the right of the tree view. 

 

 

Figure 2-36:  Create Schedule 
 

2. Select the Add  button on the bottom of the displayed Schedules, and the Schedule 
screen will appear (see Figure 2-37). 

3. Enter the required General field information. Select the schedule recurrence. The choices 
are: Daily, Weekly, Monthly, or Yearly. 

 

 

Figure 2-37:  Schedule General Tab 
 

4. Click on the Options tab, and an example of a possible screen that could appear is shown 
in Figure 2-38. 
 
If Daily is selected, then define Every, Start Date [use calendar], Start Time [click in the field 
to change time], and check Run Every to set the number of minutes. 
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If Weekly is selected, then define Recur every week(s) on X day [check box for each day] or 
check box for All Week, Start Date [use calendar], and Start Time [click in the field to change 
time]. 
 
If Monthly is selected, then define Day X of every N month(s), Start Date [use calendar], 
and Start Time [click in the field to change time]. 
 
If Yearly is selected, then define Every X month for N date, and Start Time [click in the field 
to change time]. 

 

 

Figure 2-38:  Schedule Options Tab 
 

5. Enter the required Options information. Click on the Group(s) tab, and the screen will 
appear as shown in Figure 2-39. If desired, from the Available list (default status for any 

Groups previously defined), select the Group(s) by using the selection arrows (  or 

) to move them to the Selected list on the right from the Available list on the left. 
 

 

Figure 2-39:  Schedule Group(s) Tab 
 

6. Click on the Device(s) tab, and the screen will appear as shown in Figure 2-40. If desired, 
from the Selected list (default status for devices previously defined), deselect the Device(s) 

by using the selection arrows (  or ) to move them from the default Selected list on 
the right to the Available list on the left. 

 

 
Note – The devices will be automatically selected once the Groups are selected. 
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Figure 2-40:  Schedule Device(s) Tab 
 

7. When finished defining a Schedule, click on the Save  button to save your Schedule. 

Click on the Close  button to quit without saving. The new Schedule information will be 
displayed to the right of the tree view list. 

 
 

How to Delete A Schedule 

1. To delete a Schedule in ATVS Config, click on Schedules in the tree view (see Figure 2-41). 
 

 

Figure 2-41:  Select Schedules From Tree View 
 

2. Select the desired Schedule from the list, and click on the Delete  button. A dialog box 
will appear to confirm the deletion (see Figure 2-42). 

 

 

Figure 2-42:  Confirm Deletion Dialog 
 

3. Clicking on the Yes button will delete the selected Schedule. 
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How To Modify a Schedule 

1. Select a Schedule from the list (see Figure 2-41), and double-click on it, or click on the Edit 

 button. 

2. Type in the modified information (see How to Create A Schedule) for the Schedule and click 

on the Save  button. The modified Schedule will be displayed in the tree view list. 
 
 

How to Add Groups and Devices 

A Group represents a collection of Amano TS-3000i/PIX-3000xN/PIX-3000xNT Time Recorders 
typically within a geographical area, whether that area is a floor, office, or region. Any Device 
within a Group may be in one Group, and one Group only. Groups and Devices can be added 
and defined from the ATVS Config tree view (see Figure 2-43). 
 

 

Figure 2-43:  Select Groups From Tree View 
 

How to Add a PIX-3000xNT to the System 

1. Add and define a Group. 

2. Add a Device to the Group using DeviceInstaller (used to locate PIX-3000xNT). 

3. Assign a Network Interface Card (NIC) to each Device. 

4. Configure communication parameters (IP and MAC Addresses) for each Device. 
 

To Add a Group from ATVS 

1. Click on the Groups icon in the tree view (see Figure 2-43), and the previously defined 
groups will appear to the right of the tree view. 

2. Select the Add  button on the bottom of the displayed Groups, and the Group screen 
will appear (see Figure 2-44). 

 

 

Figure 2-44:  Groups General Tab 
 
3. Enter information into the required Name field, and elective Description field. Click on the 

Enabled box to enable all devices in the group. Then click on the SNMP Server(s) tab, and 
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the screen will appear as shown in Figure 2-45. Next assign SNMP Servers, from the 
Available list (default status for SNMP Servers previously defined), select the SNMP Servers 

by using the selection arrows (  or ) to move them to the Selected list on the right 
from the Available list on the left. 

 

 

Figure 2-45:  Groups SNMP Servers Tab 
 

5. When finished entering each new Group, click on the Save  button to save the Group 

settings. When finished creating all new Groups, click on the Close  button to quit, and 
return to the Groups tree view. 

 

How To Modify a Group 

1. Select a Group from the list, and double-click on it, or click on the Edit  button. 

2. Type in the new name for the Group and click on the Save  button. The renamed Group 
will be displayed in the tree view list. 

 

How To Delete a Group 

1. Select a Group from the Groups list, and click on the Delete  button. 

2. A dialog box will appear to confirm the deletion (see Figure 2-46). Click on the Yes button. 
 

 

Figure 2-46:  Confirm Deletion 
 

How To Add a Device to the Group 

1. Click on the Groups icon in the tree view, and then expand the Groups list by clicking in the 
tree view on the +. All previously defined groups will appear. 

2. Select a Group from the expanded list and click on the Add  button for the Device 
screen to appear (see Figure 2-47). 

3. Enter a Name for the device that describes it in some meaningful way. 
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4. From the Type dropdown list, select a TS-3000i, PIX-3000xN or PIX-3000xNT. 

5. If selecting a TS-3000i and PIX-3000xNT device, enter its IP/MAC Address. If the IP 

address is unknown, select the Import Device  button to launch Import Device screen to 
auto discover the TS-3000i clock to find the IP and MAC Address. 

If selecting a PIX-3000xNT, click on the PIX-3000xNT Device Lookup  button on the 
Import Device screen to launch the DeviceInstaller program and search for IP/MAC 
addresses. See Importing Device IP/MAC Address in Chapter 4 for more information on how 
to use DeviceInstaller. 

6. For the PIX-3000xN, select the desired Com Port from the dropdown list provided. 

7. Enter in the Max Deviation that is acceptable to synchronize the Device. The maximum 
deviation is determined by the latency of the network. For this reason it should be set to a 
minimum value of 400 milliseconds, and adjusted accordingly to a higher number (default = 
1500 milliseconds). 

8. If you wish to add comments or notes on the device, enter them in the Description field. 

9. Select whether or not the device is Enabled by checking the box. The default = enabled. 
 

 

Figure 2-47:  Adding a Device 
 

10. Then click on the Other Options tab, and the screen will appear as shown in Figure 2-48. 
Either use the local computer's time zone (default), or select the appropriate Time Zone from 
the dropdown menu. The Time Zone selected controls the Time Zone adjustment sent to the 
selected device. Where OATS compliance is necessary, verify that the Use Local PC Time 
Zone option is not checked. The Time Zone must be set to (GMT-05:00) Eastern Time (US 
& Canada). 
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Figure 2-48:  Device Other Options Tab 
 

11. When finished entering each new Device, click on the Save  button to save the Device 

settings. When finished creating all new Devices, click on the Close  button to quit, and 
return to the Groups screen. 

 
 

How To Rename a Device 

1. Click on the Groups icon in the tree view, and then expand the Groups list by clicking in the 
tree view on the +. All previously defined groups will appear. 

2. Select a Group from the expanded list, double-click on it, or click on the Edit  button, 
and the Device screen will appear. 

3. Type in the new Name for the Device and click on the Save  button. The renamed 
Device will appear to the right of the Group. 

 
 

How To Delete a Device 

1. Click on the Groups icon in the tree view, and then expand the Groups list by clicking in the 
tree view on the +. All previously defined groups will appear. 

2. Select a Group from the expanded list by clicking on it to highlight the desired Device for 
that group (see Figure 2-49). 

 

 

Figure 2-49:  Deleting a Device 
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3. Click on the Delete  button. A confirmation dialog message for deletion will appear, and 
click Yes to confirm deletion. 

 
 

Device Setup and Configuration 

Before performing device setup and configuration procedure, you must: 

1. Verify that the device is powered and attached to a network via Ethernet cabling. 

2. Verify that the IP Address assigned to the device is valid. 

3. Obtain the serial number (MAC address) for the Ethernet board installed in the PIX-
3000xNT clock from the label affixed to box. This MAC address could be used when locating 
your clock with DeviceInstaller. 

 
 

Time Servers 

The Time Server selection allows you to select from the 18 default NTP time servers, or define 
your own NTP time server to synchronize the ATVS Host. You could also select a NIST, NPL, or 

PTB time servers. For example, select NTP as the server type and click on the  button 
alongside “IP Address/Host Name” to see the list of predefined NTP servers (see Figure 2-50). 

Choose the desired time server from the list, and click on the  button. Click the Close 
button when done. 
 

 
Figure 2-50:  NTP Servers 

 

 

Note – The ATVS system time must be synchronized with an NTP Server or ACTS 
before running ATVS. 

 
 

How To Add Time Servers 

1. Click on the Time Servers icon in the tree view (see Figure 2-51), and all previously defined 
time servers will appear to the right. 

 

 

Figure 2-51:  Selecting a Time Server 
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2. Click on the Add  button, and the Time Server screen will appear (see Figure 2-52). 
 

 

Figure 2-52:  Adding a Time Server 
 

3. Enter a Name, and select the Server Type from the dropdown. The server type choices are: 

NTP, NIST (US), NPL (UK), or PTB (DE). For NTP, click on the  button and a list of 
18 predefined NTP servers will appear to choose from (see Figure 2-50). This list is the 
same 18 NTP servers predefined in the TS-3000i clock. 

For NIST, NPL, or PTB, click on the  button and the default modem phone number 
for the server will appear in the Phone Number field. Also, the Com Port field will be active 
to enter the desired Com Port. 

4. The IP Address/Host Name field will be auto populated with the information from the 
default NTP Time Server if one is selected. 
 
However, if a different Time Server such as an internal Time Server is desired, enter the  
IP Address/Host Name in this field. 

5. Enter in the Max Deviation that is acceptable to synchronize the ATVS Host. The default 
value is 1.5 seconds or 1500 milliseconds. 

6. The Last Successful Sync and Last Sync Attempt are read-only fields that display the 
successful sync and last sync attempt of the schedule. The Description field enables you to 
type in comments or remarks about the server. 

7. Place a check in the Enabled checkbox to enable the NTP server. 

8. To save these Time Server settings click on the Save  button. The updated Time Server 
information will be displayed to the right of the tree view list (see "Deleting Time Servers" 
figure for an example). 

 
 

How To Delete a Time Server 

1. Click on the Time Server icon in the tree view, and all previously defined time servers will 
appear. Also, a time server can be selected from the list on the right in the time server 
screen. 

Click on Select Button 
to see a list of 
predefined NTP Time 
Servers. 
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2. Select a time server from the expanded list by clicking on it to highlight the desired time 
server (see Figure 2-53). 

 

 

Figure 2-53:  Deleting Time Server 
 

3. Click on the Delete  button, and a confirmation dialog message for deletion will appear. 
Click Yes to confirm deletion. 

 
 

How To Define the Time Server Sequence 

1. Click on the Time Servers icon in the tree view (see above figure), and then expand the 
Time Servers list by clicking in the tree view on the +. All previously defined time servers will 
appear. 

2. Click on the Sequence icon in the tree view to display the time Servers in sequence  
(see Figure 2-54). 

 

 

Figure 2-54:  Time Server Sequence 
 

3. Define the sequence order by selecting a time server and using the up  and  down 
move arrows. 

4. To save this Sequence setting click on the Save  button. 
 
 

General System Options 

The system settings for ATVS are located in System Options (see Figure 2-55). These settings 
include Time Zone, DST, NTP Time Server Sync Cycle Retry number (# of retries for a sync 
failure), option to send SNMP Trap/Email for failed server sync attempt(s), and Scheduler Time 
Format [12 hour AM/PM or Military]. 
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To modify System Options, click on the System Options icon in the tree view, enter the new 

information. Click on the Save  button to save the modified System Options settings. 
 

 
Figure 2-55:  System Options 

 
 

Time Zone 

Use Local PC Time Zone: This option should only be checked in areas where OATS 
compliance is not required, but sync to local time is. 

However, for OATS compliance, verify that the Use Local PC Time Zone option is not checked. 
The Time Zone must be set to (GMT -05:00) Eastern Time (US & Canada). 

Daylight Savings Time Not Applicable: This option should only be checked in areas where 
DST is not used, and OATS compliance is not required. 

Ignore NTP Time Server deviation error after the first sync cycle: This option should be 
checked if you want to send Trap/Email only for the last failed server sync attempt. 

Only send Time Server failure messages [SNMP trap and/or email] if it completely fails to 
download the time: This option should only be checked if you want to send Trap-Email only for 
all failed sync servers. 

Time Server Sync Cycle Retry: Default = 3. This option is the amount of times the Time Server 
will try to connect and sync time. 

Service Port: Default = 7. Can be any unused port from 1 thru 65535. This is the port that is 
dedicated to listen to the TS-3000i clock(s). If this port is not set the same as the clock(s) it will 
not detect clock emails, on-line/off-line, etc. 

Scheduler Time Format: From the dropdown menu select either 24 hour military, or 12 hour 
(AM/PM). 
 

General E-Mail Settings 

The E-Mail settings for ATVS are located in E-Mail. These settings include SMTP Server Name, 
Port, Authentication required [Username and Password], and whether or not secure connection 
(SSL) is required. 

To modify general E-Mail settings, click on the E-Mail icon in the tree view (see Figure 2-56), 
and enter the new information. To save the modified general e-mail settings click on the Save 

 button. 
 



 

2-32 ATVS Enterprise Edition v5.2 Installation & Operation Guide 

 

 

Figure 2-56:  General E-Mail Settings 
 
 

How To Delete E-Mail Account and/or Template 

1. Click on the E-Mail icon in the tree view, and then expand the E-Mail list by clicking in the 
tree view on the +. All previously defined e-mail accounts and templates will appear when 
you click on the Accounts or Templates icon in the tree view. 

2. Select an E-Mail Account or Template from the expanded list by clicking on it to highlight 
the desired account or template for the e-mail notification (see Figure 2-57 and Figure 2-58). 

 

 

Figure 2-57:  Deleting E-Mail Account 
 

 

Figure 2-58:  Delete E-Mail Template 
 

3. Click on the Delete  button, and a confirmation dialog message for deletion will appear. 
Click Yes to confirm deletion. 
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How To Add E-Mail Account and/or Template 

1. Click on the Accounts or Templates icon in the tree view (see Figure 2-57 and Figure 2-58), 
and all previously defined E-Mail Accounts or Templates will appear to the right of the icon. 

2. Click on the Add  button, and the E-Mail Account or E-Mail Template screen will appear 
depending on which was selected (see Figure 2-59 and Figure 2-60). 

 

 

Figure 2-59:  Add E-Mail Account 
 

 

Figure 2-60:  Add E-Mail Template 
 

In the E-Mail Account screen, the E-Mail To field is where the e-mail notification from ATVS 
will be sent. 

 

In the E-Mail Template screen, the From E-Mail field is the From e-mail on the notification 
(i.e., a clock failed to sync message sent) e-mail sent by the ATVS. The Message, Event, 
and Time Server Name information will appear in the e-mail. Also, the Subject field will be 
included. See the following example figure. 

3. Place a check in the Enabled checkbox in the E-Mail Account screen to enable that e-mail 
account for use. 

4. Place a check in the Enabled checkbox in the E-Mail Template screen to enable that e-mail 
template for use. 

5. For the E-Mail Template, enter a Name, select the From E-Mail from the dropdown, and 
select the Event from the dropdown. Enter the Subject (see Figure 2-61 for an example e-
mail notification sent by ATVS) and desired Message. 
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Figure 2-61:  Example of E-Mail Notification 
 

6. To save these E-Mail Account and E-Mail Template settings click on the Save  button. 
The updated E-Mail Account and Template information will be displayed to the right of each 
tree view list (see "E-Mail Account List" Figure 2-57 for an example). 
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Chapter 3: ATVS Scheduler Operation 
The ATVS Scheduler runs as a service for the ATVS Enterprise software. The ATVS 
Scheduler window consists of two tabs: Actions and Previous Action Log. 

To start the ATVS Scheduler, click on the ATVS Scheduler  icon and the ATVS 
Scheduler screen will appear (see Figure 3-1). 
 

 

Figure 3-1:  ATVS Scheduler 
 

At startup, the ATVS Scheduler will check each PIX-3000xNT device and verify the assigned 
NIC IP Address. If the NIC IP Address is invalid, an error message will appear in the Actions 
Log stating that the PIX-3000xNT device does not have a valid IP Address. 

To correct this you must open the ATVS Config program by clicking on the ATVS  Icon. 

Click on the Tools Menu in ATVS Config, and select the sub-menu Device Lookup, which will 
launch DeviceInstaller (see Importing TS-3000i & PIX-3000xNT into ATVS). From 
DeviceInstaller you have to either assign another NIC to the affected PIX-3000xNT(s), or re-
enter the IP address of the NIC in question. 
 
 

Actions Log 

The Actions tab functions as a real-time monitor of actions performed by the ATVS Host. 

As each action is performed, its description with date and time is displayed as a line item. When 
completed, the next scheduled action to occur is listed with the date and time. For an 
explanation of the events recorded, click on the Help button or refer to Action Log Messages for 
a complete listing of messages. 
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Note:  A message in the actions log in blue indicates a warning, while a message in red 
indicates a failed task (see figure). 

 

 
Figure 3-2:  ATVS Scheduler Actions Log 

 

These messages will continue to be displayed on the screen for up to 200 scrollable lines, at 
which time the system will automatically save them to a database. A database is created for 
every day ATVS is run, and then archived by the system. Previous databases can be viewed on 
screen in the Previous Action Log tab or by using ATVS Reports. 

From the menu click on File, and select Clear to clear the currently displayed Actions Log. 

The system can be operated manually through the use of the menu selections. This will attempt 
to obtain the correct time from an NTP server or NIST-ACTS before the devices are 
synchronized. This is accomplished by using the Previous Failed Sync sub-menu selection 
from the Run menu in ATVS Scheduler (see Figure 3-3). 
 

 
Figure 3-3:  Run Menu in ATVS Scheduler 

 

After selecting "Previous Failed Sync", click on the devices you want to sync and then click on 
the Sync button (see Figure 3-4). 
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Figure 3-4:  Sync Previously Failed Sync Device(s) 
 

From the Run menu select Schedules from ATVS Scheduler (see Figure 3-5), select a 

schedule(s) [previously defined], and click on the Run  button to execute that 
schedule(s). 
 

 

Figure 3-5:  Run Schedules From ATVS Scheduler 
 
 
 
 



 

3-4 ATVS Enterprise Edition v5.2 Installation & Operation Guide 

Previous Action Log 

The Previous Action Log tab allows you to access the database generated when the Action 
Log is automatically saved. A database is generated every day ATVS is run. 

From the menu click on File, and select Clear (see Figure 3-6) to clear the currently displayed 
Previous Action Log (see Figure 3-6). 
 

 
 

 

Figure 3-6:  Previous Action Log 
 

To retrieve a Previous Action Log, enter a start and end date in the appropriate fields and click 
on the Retrieve button. If the database exists, its contents will be displayed (see Figure 3-6). 
For an explanation of the events recorded in the database, refer to Action Log Messages for a 
complete listing of messages. Click on Help menu and select About (see Figure 3-7) for the 
ATVS Scheduler version. 
 

 

Figure 3-7:  ATVS Scheduler About 
 

Exiting The Program 

From the File menu, click on Exit to close the ATVS Scheduler window. However, ATVS 
Scheduler will still be running as a service in the background for the Enterprise version. 
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Chapter 4: Importing TS-3000i & PIX-3000xNT into ATVS 
Amano recommends using the DeviceInstaller to find, import, and or configure PIX-3000xNT 
clocks for ATVS. From ATVS Config click on the Tools menu, and then select the Device 
Lookup sub-menu to launch DeviceInstaller (see Figure 4-1). 
 

 

Figure 4-1:  DeviceInstaller Main View 
 

Also, the hardware/MAC address can be obtained from a label on the PIX-3000xNT Time 
Recorder. 
 

 

Note – DeviceInstaller can also be launched by opening the Device screen from 
ATVS. With the Device screen open, select PIX-3000xNT for device type. Then click 

on the Import Device  button on the bottom of the screen. When Import Devices 
screen opens up, click on the  

PIX-3000xNT Device Lookup  button and DeviceInstaller will open. 
 

Amano recommends using the Import Device function to find, import, and or configure  
TS-3000i clocks for ATVS. From ATVS Config click on the Tools menu, and then select the 
Import Devices sub-menu to launch Import Devices screen (see Figure 4-2). 
 

 

Figure 4-2:  Import Devices for TS-3000i 
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Importing Device IP/MAC Address 
 

How to Import PIX-3000xNT 

1. With the DeviceInstaller open, click on the Magnifying glass  to search for the  
PIX-3000xNT IP/MAC addresses. Figure 4-3 shows an example of a search. 

 

 

Figure 4-3:  DeviceInstaller Search Results Example 
 

2. All PIX-3000xNT devices that are detected here may be imported. If you wish to define a 
specific group for the imported device, double-click on the device and the Configure Device 
screen will appear (see Figure 4-4). 

 

 

Figure 4-4:  Configure Device 
 

3. The Configure Device screen allows you to define a name and Group for the device. 
Defining a Group here provides the DeviceInstaller import utility with the necessary 
information to install the device into the specified Group. To specify a Group, enter the 
Group name exactly as it already appears in the Groups menu in ATVS Config. When done, 
select OK. 
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 Update the Group for all devices you wish to define. All pre-defined devices will appear in 
the DeviceInstaller grid (see Figure 4-5) with the Group defined in the Group heading. 

 

 

Figure 4-5:  DeviceInstaller Grid Results Example 
 

 If no group is specified, each device imported will automatically be installed to a default 
group. If the group associated to a device needs to be changed at a later time, please refer 
to the section Moving a Device to Another Group. 

4. Click on File and select the Save As sub-menu (see Figure 4-6). 
 

 

Figure 4-6:  DeviceInstaller File Menu 
 

5. From the Save As dialog (see Figure 4-7), select a destination folder [Save in:] and File 
name. Click the Save button and a text file with the IP search results will be saved. 

 

 

Figure 4-7:  Save As Dialog 
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6. Close the DeviceInstaller, and from the ATVS Config main screen click on the Groups icon 
in the tree view to expand the Groups list by clicking in the tree view on the + to list all 
Groups/devices and select the PIX-3000xNT Default Group (if it exists). This group is 
automatically created the first time a PIX-3000xNT is imported. To the right of the Groups 
shown in the tree view will be a list of the devices connected to that group. 

 

 

Note – However, the PIX-3000xNT clock could manually be added to a specific group. 
See “Moving a Device to Another Group” for how to move devices. 

 

7. Select the PIX-3000xNT (Default Group) to import the PIX-3000xNT device to. Click on the 

Add  button to create a new device and the Device screen will appear (see Figure 4-8). 
Select PIX-3000xNT from the dropdown menu for device type. 

 

 

Figure 4-8:  Add Device 
 

8. Click on the Import Device(s)  button on the bottom of the Device screen to open to the 
Import Devices screen. 

9. Select PIX-3000xNT from the dropdown menu for the type of device to import  
(see Figure 4-9). May already be selected. 

 

 

Figure 4-9:  Select PIX-3000xNT Device Type 
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10. Click alongside the Import File Location field on the Browse  button and navigate to the 
saved “Devices.txt” file previously created (see Figure 4-7). Once the file is selected, click on 
the Open button and the path for the text file with the IP/MAC search results will appear in 

the "Import File Location" field (see Figure 4-10). Click on the Load File  button to 
load this information into the Import function and the device status information will appear on 
the bottom of the Import Devices screen in the operation status field (see Figure 4-10). 

 

 

Figure 4-10:  Load PIX-3000xNT Device 
 

11. Click on the Import tab to display a list of PIX-3000xNT devices to import that you just 
loaded (device.txt file) from the previous step. Just select the desired devices to import if you 
do not want to import all the devices on the list (see Figure 4-11). 

 

 
Figure 4-11:  Device List from Loaded Devices 

 

12. Click on the Import Selected Device(s)  button to import all the 
selected PIX-3000xNT devices. The operational status of the import will be displayed below 
on the Import Devices screen. 
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13. Close the Import Devices screen and you will be back on the Device screen. If you started 
from the PIX-3000xNT Default Group, click on the device from the list on the right and that 
device information will appear in the proper fields (see Figure 4-12). If you did not start from 
the PIX-3000xNT Default Group, you will have to navigate to that group from the ATVS 
Config main screen by clicking on the Groups icon in the tree view and selecting the  
PIX-3000xNT Default Group. 

 

 
Figure 4-12:  Import Device Information 

 

14. Click on the Other Options tab, and the screen will appear as shown in Figure 4-13. Either 
use the local Time Zone, or select the appropriate time zone from the dropdown menu. The 
Time Zone selected controls the specific Time Zone adjustment sent to the individual PIX-
3000 device currently being configured within your ATVS setup. The setup for each PIX-
3000 device allows for custom Time Zone configuration. Where OATS compliance is 
necessary, verify that the Use Local PC Time Zone option is not checked. The Time Zone 
must be set to (GMT-5:00) Eastern Time (US & Canada). 

 

 

Figure 4-13:  Create Device Other Options Tab 
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15. When finished entering importing each new PIX-3000xNT device, click on the Save  
button to save the device settings. When finished importing new devices, click on the Close 

 button to quit and return to the ATVS Config screen. 
 
 

How to Import TS-3000i 
 

1. From ATVS Config click on the Tools menu, and then select the Import Devices sub-menu 
to open Import Devices screen. 

2. Select TS-3000i from the dropdown menu for the type of device to import (see Figure 4-14). 
 

 

Figure 4-14:  Select Device Type 
 

3. This step is optional and should usually be skipped for TS-3000i import. Only perform this 
step if having problems with auto discovery. Please note - the screen has changed (see ) to 
allow Domain Name change for the search (default = local). Also, you can select the timeout 
time allowed for the search from the dropdown (default = 1 minute). 

 

 

Figure 4-15:  Normal Import TS-3000i Settings 
 

4. Click on the Import tab to display a blank Import Devices screen. Click on the  

Start TS-3000i Discovery  button. To stop auto discovery, simply click on the  

Stop TS-3000i Discovery  button. Searching for the clocks will automatically timeout. 

5. All of the discovered TS-3000i clocks will be displayed in a list with their Device Type, IP 
Address, MAC Address, Device Name, and Group Name (they will automatically be given 
the group name of “TS-3000i Default Group” (see Figure 4-16). 
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Figure 4-16:  Discovered TS-3000i Clocks 
 

6. Select the desired TS-3000i clocks and click on the  button to import 
these clocks into the ATVS software. The dialog “Are you sure” will appear (see Figure 
4-17). Click the OK button to perform the operation. The operational status will appear in the 
display window to show that the selected clock(s) have been imported (see Figure 1-29). 

 

 

Figure 4-17:  Confirm Import Dialog 
 

7. Close the Import Devices screen, and from the ATVS Config main screen click on the 
Groups icon in the tree view to expand the Groups list by clicking in the tree view on the + to 
list all Groups/devices and select the TS-3000i Default Group (if it exists). This group is 
automatically created the first time a TS-3000i clock is imported. To the right of the  
TS-3000i Default Group shown in the tree view will be a list of the TS-3000i devices 
connected to that group. 
 

 

Note – However, the TS-3000i clock could manually be added to a specific group. 
See “Moving a Device to Another Group” for how to move devices. 

 

8. Select the desired TS-3000i imported clock from the group list by double-clicking on it or 

clicking on the Edit  button. All devices belonging to that group will appear in the right-
hand side (see Figure 4-18). The name, IP and MAC addresses will automatically be 
brought into the device file. Note – the Description field will be auto-populated with the text; 

“This device was created in the import module.” Also, the Launch Web Browser  button 
will appear alongside the clock name to automatically connect to the clock Web page when 
clicked on. 
 
To add TS-3000i clocks to ATVS at a later time, just repeat the process detailed here. 
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Figure 4-18:  Device Imported TS-3000i Selection 
 

 If the group associated to a device needs to be changed at a later time, please refer to the 
section Moving a Device to Another Group. 

 

16. Click on the Other Options tab, and the screen will appear as shown in Figure 4-19 . Either 
use the local Time Zone, or select the appropriate time zone from the dropdown menu. The 
Time Zone selected controls the specific Time Zone adjustment sent to the individual PIX-
3000 device currently being configured within your ATVS setup. The setup for each PIX-
3000 device allows for custom Time Zone configuration. Where OATS compliance is 
necessary, verify that the Use Local PC Time Zone option is not checked. The Time Zone 
must be set to (GMT-5:00) Eastern Time (US & Canada). 

 

 

Figure 4-19:  Create Device Other Options Tab 
 



 

4-10 ATVS Enterprise Edition v5.2 Installation & Operation Guide 

17. When finished entering importing each new TS-3000i device, click on the Save  button 

to save the device settings. When finished importing new devices, click on the Close  
button to quit and return to the ATVS Config screen. 

 
 

Moving a Device to Another Group 

1. Click on the Groups icon in the tree view, and then expand the Groups list by clicking in the 
tree view on the + to list devices. All previously defined groups and associated devices will 
appear (see Figure 4-20). To the right of the Groups shown in the tree view will be a list of 
the devices connected to that group. 

 

 

Figure 4-20:  Drag and Drop a Device 
 
2. To move a device, select a device from the expanded list by clicking on it, hold down the 

mouse button, and drag-n-drop the device on top of the group in the tree view on the left 
that you want to move it to (see above figure). 

Note When a device is imported using the importing procedure a group name will 
automatically be created. If this occurs, it might be necessary to move a device to the 
desired group name. If a blank group (non-desired) group remains, move up in the tree 
view to the group level and delete it. 
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Chapter 5: ATVS Reports 
ATVS Reports enables the user to generate, view, save the report file, and print reports 
containing: 

 Device settings. 

 Device synchronization schedules by Schedule or by day of the week. 

 Time sources (NTP servers and dial-up services). 

 The transaction log by specific date or date range. 

 The status and condition of each Device in the system. 

Figure 5-1 shows an example of what the reports listing looks like after clicking on the Reports 
icon from the tree view. 
 

 
Figure 5-1:  ATVS Config Reports 

 

How To Create a Report 

1. Click on the Reports icon in the tree view, and any previously defined Reports will appear. 

2. Click on the Add  button, and the blank Report Profile screen will appear  
(see Figure 5-2). 

 

 

Figure 5-2:  Creating A Report Profile 
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3. Enter a Name, and select the report Type from the dropdown list. The report type choices 
are; Device, Schedule, Time Server, Transaction, or Status. 

4. The Description field allows the user to type comments or remarks about the report. Click 
on the Advanced tab, and a screen may appear as shown in Figure 5-3. 

 

 

Note – The Advanced tab screen selections will vary depending on the report type 
selected. 

 

 

Figure 5-3:  Report Profile Advanced Tab 
 

5. Individually select the desired devices (i.e., TS-3000i) and/or item(s) to show on the report, 
or click on Select All to show on the report. 

6. Define the Last Sync Range by clicking on Today, or Date Range. Then click on the Sort 
Options tab, and the screen will appear as shown in Figure 5-4. 

 

 

Figure 5-4:  Report Profile Sort Options Tab 
 

7. Define the sort/filter options by clicking on Device Name and selecting from the dropdown 
list: Device Name, IP Address, COM Port, or MAC Address. Also, define the sequence 

report filter order by selecting a type and using the up  or  down move arrows. Then 
click on the Groups tab, and the screen will appear as shown in Figure 5-5. 
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Note – The Sort Options tab will not be present for Status and Transaction Reports. 

 

 

Figure 5-5:  Report Profile Groups Tab 
 

8. If desired, from the Available list (default status for Groups previously defined), select the 

Group(s) by using the selection arrows (  or ) to move them to the Selected list on 
the right from the Available list on the left. 

 

 

Note – This tab will not be present for Schedule, Time Server, and Transaction 
Reports. 

 

9. Then click on the Devices tab, and the screen will appear as shown in Figure 5-6. If desired, 
from the Selected list (default status for devices previously defined), deselect the Device(s) 

by using the selection arrows (  or ) to move them from the default "Selected" list 
on the right to the "Available" list on the left. 

 

 

Note – The devices will be automatically selected once the Groups are selected in the 
previous step. The Devices tab will not be present for Schedule, Time Server, and 
Transaction Reports. 

 

 

Figure 5-6:  Report Profile Devices Tab 
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10. Then click on the E-Mail tab, and the screen will appear as shown in Figure 5-7. If desired, 
from the Available list (default status for E-Mail accounts previously defined), select the E-

Mail To by using the selection arrows (  or ) to move them to the "Selected" list on 
the right from the "Available" list on the left. 

 

 

Figure 5-7:  Report Profile E-Mail Tab 
 

Use the Select E-Mail button to choose an e-mail address for the E-Mail From address  
(see Figure 5-8). 
 

 

Figure 5-8:  Selecting E-Mail Account 
 

11. When finished with defining the report profile, click on the Save  button to save your 

report profile settings and return to the Reports screen. Click on the Close  button to 
quit without saving. The new Report Profile information will be displayed to the right of the 
tree view list (see Figure 5-1). 

 
 

How To Run a Report 

1. Click on the Reports icon in the tree view, and all previously defined Reports will appear. 

2. Select a report from the list on the right by clicking on it to highlight the desired report  
(see Figure 5-9). 
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Figure 5-9:  Selecting an ATVS Report 
 

3. Click on the Run Report  button and the report will be created and/or formatted based 
upon the previously defined report/filter criteria. See later in this section for descriptions of 
the five available report types. 

 

How To Print a Report 

1. Click on the Reports icon in the tree view, and all previously defined Reports will appear. 

2. Select a report from the list on the right by clicking on it to highlight the desired report  
(see Figure 5-9). 

3. Click on the Run Report  button and the report will be created and/or formatted based 
upon the previously defined report/filter criteria. See later in this section for descriptions of 
the five available report types. 

4. From the top of the report screen, click on the Print Report  button, and the Windows 
print dialog screen will appear (see Figure 5-10). 

 

 

Figure 5-10:  Windows Print Dialog 
 

How To Create a Report File 

Follow the preceding procedure for printing a report. 

1. When the Windows Print dialog window appears (see Figure 5-10) click Print to File  
(see Figure 5-11). 
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Figure 5-11:  Select File Type 

 

2. Select the desired Format from the dropdown list. The report format choices are; PDF, 
Word (RTF for Word), Excel, or Image. 

3. Click on the Browse  button to select the file destination, and the Save As dialog will 
appear (see Figure 5-12). 

 

 

Figure 5-12:  Windows Save As Dialog 
 

4. Enter a file name, select a file type, and click on the Save button. The Print dialog screen 
will appear again. Click on the Ok button and the file will be created in the defined 
destination. 

 

How To Delete a Report Profile 

1. Click on the Reports icon in the tree view, and all previously defined Reports will appear. 

2. Select a report from the list on the right by clicking on it to highlight the desired report. 

3. Click on the Delete  button. A confirmation dialog message for deletion will appear; click 
Yes to confirm deletion. 
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How To Modify a Report Profile 

1. Select a Report from the list, and double-click on it, or click on the Edit  button. 

2. Type in the new information for the Report Profile and click on the Save  button. The 
redefined Report Profile will be displayed in the tree view list. 

 
 

How To Navigate a Report 

To navigate through any generated report use the Zoom In/Zoom Out ( ) buttons 

and/or First/Previous/Next/Last Page  buttons. 

To print a generated report use the Print Report  button. See Figure 5-13 for a report 
example. Reports will be generated (formatted) based upon the filter criteria selected in the Sort 
Options of the report profile. 

To quit a generated report use the Close  button and return back to the reports list 
screen. 

Reports will be generated (formatted) based upon the filter criteria selected in the Sort Options 
of the report profile. 
 
 

Device Report 

To generate a report, select a device report from the reports list and click on the Run Report 

 button. This report can be sorted by Device Name, IP Address, Com Port, or MAC 
Address. If desired, this report can be formatted with page breaks, and in ascending order. 
Figure 5-13 is an example of a displayed Device Report. 
 

 
Figure 5-13:  Device Report Example 

 

 

Note – As a convenience feature, the Device Report will also list on the top the total 
number of devices selected for the report and the total number of devices in the 
system. 

 



 

5-8 ATVS Enterprise Edition v5.2 Installation & Operation Guide 

 

Schedule Report 

This report displays the Device Synchronization Schedules. This report can be generated for the 
following schedule types: Daily, Weekly, Monthly, or Yearly. This report can be formatted with or 
without page breaks, and in ascending/descending order. Figure 5-14 is an example of a 
displayed Schedule Report. 
 

 

Figure 5-14:  Schedule Report Example 
 
 

Time Server Report 

When selected, this option will generate a report containing any or all the time sources, NTP 
servers and dial-up services, in the database. This report can show the following server types: 
NIST, NTP, NPL, PTB, Enabled, Disabled, last successful sync, and/or last sync attempt. A 
report can be generated for today or a date range with starting and ending date and time. 

This report can be formatted with or without page breaks, and in ascending/descending order. 
Additional sorting/filtering can be performed by: Time Server Name, IP Address/Host Name, 
Telephone Number, and Com Port. Figure 5-15 is an example of a displayed Time Server 
Report. 
 

 

Figure 5-15:  Time Server Report Example 
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Transaction Report 

The Transaction Log Report is used to generate a report of a log based on a specific date 
(today) or a date range (Log Report) with a starting and ending date and time. Figure 5-16 is an 
example of a displayed Transaction Report. 
 

 

Figure 5-16:  Transaction Report Example 
 
 

Status Report 

A Status Report is a simple way of checking the status of each Device in your system. To 

generate a report, select a group or groups from the Available Events list and click on the  

or  buttons to move them to the Selected Events list. The choices for events are: failed to 
sync with the time server, failed to communicate with the clock, and successful synchronization. 

Select the Groups to run the report(s) for, and the Devices assigned to those Groups will 
automatically be selected. Figure 5-17 is an example of a displayed Status Report. 
 

 
Figure 5-17:  Status Report Example 

 

 

Note – In a report, if a Device had failed synchronization, the word “Failed” will be in 
the Sync Status column in red. 
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Chapter 6: Action Log Messages 
Unless otherwise specified, the messages listed will appear in the status section when either a 
Actions or Previous Actions Log is selected. To see these messages startup the ATVS 
Scheduler. Figure 6-1 is an example of the ATVS Scheduler. 
 

 

Figure 6-1:  ATVS Scheduler 
 
 

Startup and Shut Down Messages 

Initialize Initiated... 

Date Time: Device synchronization scheduler started. 

xxx Actions Scheduled 

Date Time: Number of schedules defined. 

Action List [xxx]. Time = MM/DD/YYYY hh:mm:ss message1, message2 

Date Time: Attempting to run schedule. 

Initialize Succeeded. 

Configuration initialization completed. 

Network Time Synchronization Messages 

Trying to connect to server #xx 

Where xx is the Server Name. ATVS is attempting to connect to the specified NTP 
server. 

Time From Server #xx 

Where xx is the Server Name. ATVS received time information from the specified NTP 
server.  
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Deviation From Time Server xx = HH:MM:SS.SSS 

Where xx is the Server Name and HH:MM:SS.SSS is the time deviation between the 
ATVS Host and the NTP server. When the time is received from the NTP server, it is 
compared with the ATVS Host. If the difference between the two is greater than the 
Maximum Deviation, the NTP server time is considered incorrect.  

Connecting to IP Address XXX.XXX.XXX.XXXX 

Where XXX.XXX.XXX.XXX is the IP Address. ATVS is in-process of connecting to the 
specified NTP server. (Detailed Activity Logging only) 

Connected to server xx NNN 

Where xx is the Server Name and NNN is the server name. ATVS has successfully 
connected to the specified NTP server. (Detailed Activity Logging only) 

Attempting to synchronize to the Time Server(s): Retry #xx.  

Where xx is the number of retry. No time data was received from seven out of ten NTP 
servers in the first time through the cycle. 

Could not resolve server xx host Server Location: XXX.XXX.XXX.XXXX 

Where xx is the Server Name and XXX.XXX.XXX.XXX is the IP Address or Host Name. 
The IP Address entered for the NTP server is incorrect, or the DNS translation option is 
not enabled. (Detailed Activity Logging only) 

Could not receive information from server xx, XXX.XXX.XXX.XXXX 

Where xx is the Server Name and XXX.XXX.XXX.XXX is the IP Address or Host Name. 
No time data was received from the NTP server. The system will attempt to make five 
connections until successful. (Detailed Activity Logging only) 

Deviation Error From Time Server :xx 

Where xx is the Server Name. When the time is received from the NTP server, it is 
compared with the ATVS Host. If the difference between the two is greater than the 
Maximum Deviation, the NTP server time is considered incorrect.  

Failed to sync due to Timeout Error from Time Server : xx 

Where xx is the Server Name. No connection was established with the NTP server due 
to a network or server failure.  

Failed to sync due to Invalid Host from Time Server xx 

Where xx is the Server Name. The IP Address entered for the NTP server is incorrect, or 
the DNS translation option is not enabled. 

Did not receive enough data from Time Server xx, XXX.XXX.XXX.XXXX 

Where xx is the Server Name and XXX.XXX.XXX.XXX is the IP Address or Host Name. 
No time data was received from the NTP server. The system will attempt to make five 
connections until successful. 
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NIST ACTS Messages 

Preparing to dial out 

The system is initializing modem to dial NIST. 

Dialing 

The system is dialing the NIST telephone number. 

Connection established 

Connection between ATVS Host and NIST succeeded. 

Time from XXXXX : MM/DD/YYYY hh:mm:ss:nnn 

NIST time/date data successfully received from ACTS. 

Deviation from XXXXX = hh:mm:ss:nnn 

Time difference between ATVS Host and ACTS. 

Redialing 

Redialing NIST telephone number. 

The configured device is not functioning 

The Com port does not exist or is invalid on this system. 

The configured modem connection is invalid 

The Com port the modem is set to is not functioning. 

Could not receive correct information 

Connection was established but ATVS did not receive correct information. System will 
automatically redial to NIST in five minutes. 

Could not communicate with modem 

Modem may not be connected, powered on or it is not responding to the application. 

Could not connect to XXXXX modem 

Could not connect to specified modem. 
 

PIX Transmission Messages 

Starting Communication 

Device synchronization initiated. 

Transmitting time and date to pix Name : XXXXXXX (xxx.xxx.xxx.xxx) 

Transmitting time and date to Device via IP Address xxx.xxx.xxx.xxx. 

Successfully sync time to Device: XXXXXXX (xxx.xxx.xxx.xxx) Est. Latency = xxx (ms)  

or 

Successfully sync time to Device: XXXXXXX via Com X 

Where X is the Com Port #. Where XXXXXXX is the Device Name, xxx.xxx.xxx.xxx is its 
IP Address, xxxx is the Estimated Latency of the network and x is the Com Port number. 
Synchronization with the Device was successful. 
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Failed to communicate with Device XXXXXXX (xxx.xxx.xxx.xxx) 

Where XXXXXXX is the Device Name and its IP Address is xxx.xxx.xxx.xxx. This occurs 
when the IP Address entered for the specified Device does not exist, is incorrect, or the 
Device is not functioning. 

Connection request timed out 

No connection was established between the ATVS Host and the specified Device due to 
an invalid IP address, network failure, or the Device is not functioning. 

Send timed out 

The IP Address entered for the specified Device does not exist, incorrect, or the Device 
is not functioning. 

Transmitting time and date to pix xx  x 

Where x is the Com Port number, and xx is the Device Name. 

Send Succeeded COMx 

(Look on previous page for send succeeded for Com Port). 

Where x is the Com Port number. Broadcast to Com Port x was successful. 

Failed to sync time to Device xxxxxxx via Com x. 

Where x is the Com Port number and xxxxxxx is the Device Name. Broadcast to Com 
Port X has failed, and XXXXXXX is Device Name. 

The configured RS-485 connection is invalid 

The Device attached to the system is not functioning. 

Invalid Com Port setting. The Com Port does not exist on the system or it cannot be 
open. 

The Device attached to the system is not functioning 

The IP Address entered for the specified Device is incorrect, does not exist, incorrect, or 
the Device is not functioning. 

Connection request timed out 

No connection was established between the ATVS Host and the specified Device due to 
an invalid IP address, network failure, or the Device is not functioning. 

Winsock Error Code: xxxx: XXXXXXXX 

Where xxxx is the Winsock Error Code and XXXXXXXX is the Winsock Error. Typically, 
this error will occur if there is a wiring problem or the Device is not functioning. 

 

General and Other Messages 

Successfully sent E-mail : x 

E-mail was successfully sent by recipient. x is E-mail template name. 

Failed to send E-mail : x 

The ATVS Host was unable to send e-mail. x is E-mail template name. 
 

 



 

ATVS Enterprise Edition v5.2 Installation & Operation Guide 6-5 

 

Troubleshooting 

The basic guidelines for troubleshooting error or failure messages are as follows: 

 Check all electrical connections, and verify that all computer ports and Devices are properly 
configured and functioning. 

 Verify that the specified IP/Mac Addresses are entered correctly and enabled. 

 Consult the PIX-3000x Operation Manual for more details on clock operation. 

 Consult the TS-3000i Installation and Operation Guide for more details on clock operation. 
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